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Safety Symbols
The following symbols are used in this manual to prevent accidents which may occur as result of incorrect 
use of the instrument.

Denotes a sentence regarding safety warning or note.
Read the sentence carefully to ensure safe and correct use.

Denotes a prohibited operation.
The operation must never been performed.

Denotes an instruction.
The instruction must be strictly adhered to.

Denotes a sentence regarding safety precaution for laser.
Read the sentence carefully to ensure safe and correct use.

Notes on this Manual
• The VI-9i, VI-910, VI-900, VI-700, VI-300 are model names for Europe and VIVID 9i, VIVID 910, VIVID 900, 

VIVID 700, VIVID 300 are model names for other countries. The VIVID (VI) series digitizer includes VIVID 9i 
(VI-9i), VIVID 910 (VI-910), VIVID 900 (VI-900), VIVID 700 (VI-700), and VIVID 300 (VI-300).

• This manual gives brief explanations of basic commands only. For more details of the basic and other 
commands, refer to the Polygon Editing Tool Instruction Manual.

• Copying or reproduction of all or any part of the contents of this manual without KONICA MINOLTA 
SENSING, INC.’s permission is strictly prohibited.

• The contents of this manual are subject to change without prior notice.
• Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. 

However, should you have any questions or find any errors, please contact a KONICA MINOLTA SENSING, 
INC.  authorized service facility.

• KONICA MINOLTA SENSING, INC.  will not accept any responsibility for consequences arising from the 
use of the instrument.

• Company names and product names which appear in this manual are their trademarks or registered 
trademarks.

• Contents and display examples given in this manual are subject to change.
• Use this Basic Operation Guide and the Polygon Editing Tool Instruction Manual as a set. The Instruction 

Manual was supplied with this Guide when you bought this machine. Note that each reference page 
number or description in the Instruction Manual may vary with your Instruction Manual’s version.

About This Manual and Related Documents
This document describes the operating procedures for the basic operation of the Polygon Editing Tool.
• The Polygon Editing Tool can be used with each of KONICA MINOLTA SENSING, INC.’s non-contact 3-D 

digitizers in the VIVID series (VIVID 300/700/900/910/9i); however, the explanations provided in this 
document are based on the VIVID 9i (VI-9i) and the VIVID 910 (VI-910).

The information in this guide manual is arranged as shown below. 

Document Content

Polygon Editing Tool
Instruction Manual

Explains how to install and use the Polygon Editing Tool, and gives 
details about all of the software's features. The Polygon Editing Tool 
can be used to control the operation of VIVID non-contact 3D digitiz-
ers, to convert scanned data into polygon data, to edit and process the 
scanned data, and to save the data into standard formats.
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Safety Precautions
When using this software, the following points must be strictly observed to ensure correct and safe use.
After you have read this manual, keep it in a safe place so that it can be referred to easily whenever it is 
needed.

WARNING Failure to adhere to the following points may
result in death or serious injury.

To ensure correct and safe use of this software, please read the instruction manuals of 
the VIVID (VI) series digitizer and personal computer in addition to this manual before 
operating. Incorrect operation of the software may result in fire or electric shock.

Never stare into the VIVID’s laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam 
from VIVID. Doing so may converge the laser beam, resulting in damage to 
your eyes, burns or fire. To prevent the above accidents, make sure that a wall 
or similar which can block the laser beam is located behind the object.

 

Software Restrictions
• Copying or reproduction of all or any part of the contents of this software and manual without KONICA 

MINOLTA SENSING’s permission is strictly prohibited.
• The specifications of the software are subject to change without prior notice.
• KONICA MINOLTA SENSING, INC.  will not take any responsibility for damage caused as result of use of 

this software.

Notes On Use
• When inserting a CD-ROM into the CD-ROM drive, make sure that it is placed straight in the right direc-

tion, and inserted gently.
• Keep the CD-ROM clean. If it becomes dirty, a reading or writing error may result.
• Pay attention to rapid temperature changes and dew condensation.
• Keep the CD-ROM away from direct sunlight or heaters.
• Do not let the CD-ROM drop or be exposed to strong shocks.
• Keep the CD-ROM away from water, alcohol, thinner etc.

Notes On Storage
• Do not store the CD-ROM in a hot area, for instance, in direct sunlight or near heaters.

Document Content

Instruction Manual for each 
model in the VIVID series of 
non-contact 3D digitizers.

VIVID digitizers offers rapid, high-precision 3D scanning ideal for imag-
ing of industrial products in a wide range of shapes and configurations. 
This manual describes the digitizer's features and operating proce-
dures, and calls attention to relevant precautions.

Bench Top Frame Set 
Instruction Manual

This manual explains how to set up the Bench Top Frame Set, which 
offers more stable measurements both horizontally and vertically, and 
how to attach the VIVID 910/VI 910 to the set. This frame set is for use 
with VIVID 910/VI 910 only.
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Flow of Operations (Contents)
Step1 : Importing Image Data 4

Reads data into Polygon Editing Tool for processing, editing, and saving.
[ VIVID 9i ]  [ VIVID 910 ]
Selecting a digitizer ……………………………4 Selecting a digitizer ……………………12
One Scan ………………………………………5 One Scan …………………………………13
Step Scan ………………………………………7 Step Scan …………………………………15
Opening a Saved Data File ………………… 11 Opening a Saved Data File ………………19

Step3 : Changing the Element View Mode 20

This section explains how to change the way elements are displayed to facilitate selection 
of points and processing/editing of data.

Displaying Points ……………………………………… 20
Zoom …………………………………………………… 21
Orbit …………………………………………………… 22
Switching the Rendering Mode ……………………… 23

Step3 : Selecting the Item to be Processed/Edited 24

Select the element or points of the data to be processed/edited.

Selecting an Element ………………………………… 24
Displaying Points ……………………………………… 25
Canceling the Selected Points ……………………… 26
Reversing the Selection state of Point ……………… 26
Selecting Points within the Specified Rectangle Area 27

Step4 : Processing/Editing Data 28

Process/edit the selected element.

Deleting Points ………………………………………… 28
Performing Registration of Elements ……………… 29
Merging Elements …………………………………… 31
Undo …………………………………………………… 32
Redo …………………………………………………… 32

Step5 : Saving Data 33

Save the data read into Polygon Editing Tool.
Saving Elements ……………………………………………………… 33
Saving a Scene ………………………………………………………… 34
Converting to Other Formats ………………………………………… 35

If editing will not be performed, go to Step5
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Operation Tips 36

Case 1 …………………………………………………………………… 36
Scan using the rotating stage, and save the data into a DXF file.

Case 2 …………………………………………………………………… 37

Make multiple divided scans of a subject that cannot be fully digitized with a single scan, delete extrane-
ous data, and save the resulting elements.

Case 3 …………………………………………………………………… 39
To get complete 3D data for a subject that cannot be fully digitized with a single scan even when using 
the rotating stage, take several scans and then align and concatenate the resulting data.

Case 4 [ VIVID 910 ] …………………………………………………… 41
Use the bench top frame set to efficiently scan multiple subjects under the same conditions, one after 
another. (For VIVID 910 only)

Easy Align [VIVID910] 42

Aligns multiple scans.
Starting Easy Align …………………………………………………… 42
VIVID 910/VI-910 Calibration ………………………………………… 44
Scanning Preparations ……………………………………………… 46
Executing Easy Align ………………………………………………… 47

View Window structure

Top

Front

Right

Isometric

element list

Polygon Editing Tool is software 
for editing and processing poly-
gon shapes (shapes made up 
of small triangles and quadrilat-
erals which together form the 
surface of an object) scanned 
in using a digitizer or imported 
from other software. The poly-
gon shapes can be checked 
from any viewing angle as 
shown in the screenshot at left. 
In the element list, names can 
be given to the groups which 
make up the solid, and selec-
tion of each element, editing, 
display/hide, etc. make opera-
tion easy. 

｛element
window
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Selecting a digitizer
Select the VIVID connected to the computer so that it can be controlled via this software.

Ref. For details of the File-Select Digitizer command, refer to page 119, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Select Digitizer] on the [File] 

menu.

The [File-Select Digitizer] dialog box will 

appear, showing the currently selected 

digitizer.

Memo The first time you open this dialog box after installing 

this software, the box will display “None.” Once you 

have selected a digitizer, this box will indicate your 

selection.

2 Select the digitizer you want to use, and 

click the [OK] button. 

The selected digitizer can be controlled via 

the menus that appear when [File-Import- 

Digitizer] is selected.

Memo If a digitizer has already been selected and you 

switch it to another digitizer, the new digitizer will be 

usable when this software is started next time.

Step1: Importing Image Data
This section explains how to Import the data to be processed, edited or 
saved using the Polygon Editing Tool.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File

V
IV

ID
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i
V
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ID

 9
10
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One Scan
To scan images by one shot at a time controlling the VIVID 9i via the computer, follow the procedure given 
below.

Note When using VIVID 9i for the first time or when the lens has been exchanged, field calibration 
must be performed using a Field Calibration System. 

Warning
Never stare into the laser emitting window. 

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so 
may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent 
the above accidents, make sure that a wall or similar which can block the laser beam is 
located behind the object.

Ref. For details of the File – Import – Digitizer – One Scan command, refer to page 83, in the Polygon Editing Tool 

Instruction Manual.

[Operating Procedure]  

1 From the [File] menu, select [Import], [Digitizer] and then [One Scan].

The [File-Import-Digitizer-One Scan] dialog box will appear.

2 Set an object in place.

3 To display the object in the middle of 

the window, change the position of the 

object or m ove the instrument back and 

forth to change the view angle.

Note If the distance or angle to the object has been changed, 

click the [Mono] button to display the monochrome 

image to check it.

 

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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4 click the [Scan] button.

The MONITOR view displayed in the Work 

window is changed to the scanned image. 

In this step, the scan data will be displayed 

in the main window.

Note  When “AF error” occurs, click the [OK] button to close 

the message box. After that, click the [AF] button 

and click the [Scan] button again.

Memo If the [Use Color] checkbox is not checked (i.e. no 

check mark is shown), a monochrome image will be 

displayed.

5 Click on the [Store] button.

The scanned image which was displayed in the Work window appears in the Store window and the 

Work window returns to the MONITOR view.

6  Click the [OK] button.

[File-Import-Digitizer-One Scan] dialog 

box will disappear.

• If the [Save Raw Data] checkbox in the 

[File-Import-Digitizer-Option] dialog 

box has been checked, the following 

data save dialog box will be displayed. 

1. Enter the desired file name.

2. Click the [Save] button.

Note The f i le name must consist  of  alphanumeric 

characters only.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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Step Scan
To scan two or more images of the same object from different angles while controlling the VIVID 910 and 
optional turntable, follow the procedure given below.

Note When using VIVID 9i for the first time or when the lens has been exchanged, field calibration must 
be performed using a Field Calibration System.For information about how to use the field calibra-
tion system, refer to the VIVID 9i instruction manual.

Warning
Never stare into the laser emitting window. 

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so 
may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent 
the above accidents, make sure that a wall or similar which can block the laser beam is 
located behind the object.

Memo To perform step shot scan using the rotating stage, connect the stage to the computer, turn ON the power to the stage 

and check that the stage is recognized by the computer.

Ref. For details of the File-Import-Digitizer-Step Scan command, refer to page 91, in the Polygon Editing Tool Instruction 

Manual.

[Operating Procedure] 

1 From the [File] menu, select [Import], [Digitizer] and then [Step Scan].

The [File-Import-Digitizer-Step Scan] dialog box will appear.

Memo The monochrome monitor Work view currently captured by the VIVID 9i will appear in the Image area of the dialog box.

 If the Model folder contains the Chart data that is considered to be appropriate, it will be imported automatically.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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2 Place the object on the rotating stage.

The monochrome monitor Work view 

currently captured by the VIVID 9i will appear 

in the Image area of the dialog box.

3 To display the object in the middle of the window, 

change the position of the object or move the 

VIVID 9i back and forth to change the view angle.

Note If the object is not positioned in the middle of the 

window, it may not be scanned properly.

4 Click the [Option] button.

The [File-Import-Digitizer-Option] dialog 

box will appear.

Select the Port,  Model and Step to be used 

and click on the [Apply] button. The rotary 

stage will be initialized. If initialization 

is successful, the rotary stage can be 

controlled by using the Angle slide bar 

in the [File-Import-Digitizer-One Scan] 

dialog box.

Setting 90 : Scans the object at every 90 degrees 
    (four times in total).
  60 : Scans the object at every 60 degrees 
    (six times in total).
  Other : Allows you to specify the desired rotation step.
  Free : You can change angle as you like using the slide bar.

Memo When “Port” and “Model” are effective, computer does not recognize the Rotary Stage Set correctly. In such a case, set 

the power switch of the Rotary Stage Set to OFF and then to ON, and click the [Set] button.

5 After necessary settings are made, click on the [OK] button.

The settings will be set and the [File-Import-Digitizer-Option] dialog box will close.

6 Place the Calibration Chart on the rotating 

stage and scan the Calibration Chart.

Position the chart with the black line facing 

the VIVID, and place it on the rotating 

stage so that both entire side surfaces are 

observed in the viewfinder.

Note Confirm that the chart is set in the angle indicated in 

the [Current Setting] window.

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File

Step 1: Importing Image Data
V

IV
ID
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V
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7  Click the [Scan] button.

When the data is recognized as Calibration Chart data successfully:

The Calibration Chart data will be stored under the file name of chart∗∗∗∗ .cdk (“∗∗∗∗” are the last 

four digits of the main unit's serial number) in the Model folder.

Note When “Free” has been selected using the “Rotation Step” of the “Stage Parameter”, please use the [Chart Scan] 

button instead of the [Scan] button.

8 Place the object to be scanned on the 

Rotary Stage in place of Calibration 

Chart.

9 Click on the [Scan] button.

A scan will start, and a color image will be 

displayed in the work window.

10 Click on the [Store] button.

The color data displayed in the work window will appear in the store window (in the right section of 

the dialog box) and the Rotating Stage will rotate.

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File

Step 1: Importing Image Data

V
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11 Repeat Steps 9 to 10 until the desired 
 corresponding points are designated.

12 Click the [OK] button.

The data displayed in the element window 

by the Store function will remain as is.

• If the [Save Raw Data] checkbox in the 

[File-Import- Digitizer-Option] dialog 

box has been checked, the following 

data save dialog box will be displayed. 

The data comprised of multiple shots will 

be saved together with the registration 

conversion parameters as a single piece 

of data (CDK).

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File

Step 1: Importing Image Data
V
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Opening a Saved Data File
To open element or scene files saved on the computer, follow the procedure given below.

Ref. •  For the method of saving element and scene files, refer to page 33,34.

 •  For details of the File-Open command, refer to page 22, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Open] on the [File] menu.

The [File-Open] dialog box will appear.

2 From the “Look in” pull-down menu, 

select the folder in which the file to be 

opened is stored.

3 From the “File of type” pull-down menu, 

specify the type of file to be opened.

Setting Element files : Displays element files (.vvd).  

 Scene Files : Displays scene files (.scn). 

4 Click the file to be opened.

The file will be selected.

Memo In the case of element files, it is possible to select two 

or more. To select them, click them while holding 

down the [Shift] or [Ctrl] key.

5 Click the [Open] button.

The data of the selected file(s) will be 

imported and displayed in the screen.

Note In the case of scene files, only one can be opened. 

If elements have already been imported before 

opening a scene file, a dialog box will appear asking 

you whether to delete the elements. To continue to 

import a scene file, click the [OK] button.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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Selecting a digitizer
Select the VIVID connected to the computer so that it can be controlled via this software.

Ref. For details of the File-Select Digitizer command, refer to page 119, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Select Digitizer] on the [File] 

menu.

The [File-Select Digitizer] dialog box will 

appear, showing the currently selected 

digitizer

Memo The first time you open this dialog box after installing 

this software, the box will display “None.” Once you 

have selected a digitizer, this box will indicate your 

selection.

2 Select the digitizer you want to use, and 

click the [OK] button.

The selected digitizer can be controlled via 

the menus that appear when File-Import- 

Digitizer is selected.

Memo If a digitizer has already been selected and you 

switch it to another digitizer, the new digitizer will be 

usable when this software is started next time.

Step1: Importing Image Data
This section explains how to Import the data to be processed, edited or 
saved using the Polygon Editing Tool.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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One Scan
To scan images by one shot at a time controlling the VIVID 910 via the computer, follow the procedure 
given below.

Warning
Never stare into the laser emitting window. 

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so 
may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent 
the above accidents, make sure that a wall or similar which can block the laser beam is 
located behind the object.

Ref. For details of the File-Import-Digitizer-One Scan command, refer to page 55, in the Polygon Editing Tool Instruction 

Manual.

[Operating Procedure]  

1 From the [File] menu, select [Import], 

[Digitizer] and then [One Scan].

The [File-Import-Digitizer-One Scan] 

dialog box will appear.

2 Set an object in place.

A monochrome image taken by the VIVID 

910 will appear in the Image area of the 

dialog box.

3 To display the object in the middle of 

the window, change the position of the 

object or move the instrument back and 

forth to change the view angle.

Note If the object is not positioned in the middle of the 

window, it may not be scanned properly.

 

4 To view the color image, click the [Color] 

button.

A color image taken by the VIVID 910 will 

appear in the Image area of the dialog box.

Note If the distance or angle to the object has been changed, 

click the [Mono] button to display the monochrome 

image to check it.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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5 Select a scan mode.

In the [Camera1] tab page, click the [Fine] or [Fast] radio button.

Setting Fast : Scans the image in approximately 0.3 seconds. However, the number of pixels will drop to approximately 1/4 of

     that taken in Fine scan mode.

 Fine : Produces an image with a resolution of 640 × 480.

6 From the [General] tab, click the [Scan] 

button.

Scan will start, and both color and range 

images will be displayed.

7 Click the [Convert] button.

The [Remote-Convert] dialog box will 

appear.

8 Enter the desired element name and 

click the [OK] button.

The scanned image will be displayed.

Note The element name must consist  of  up to 31 

alphanumeric characters.

• If the [Save CDM] checkbox is checked, 

the [Remote -Save]  dialog box will 

appear.

1. Enter a file name.

2. Click the [Save] button.

Note The f i le name must consist  of  alphanumeric 

characters only.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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Step Scan
To scan two or more images of the same object from different angles while controlling the VIVID 910 and 
optional turntable, follow the procedure given below.

Warning
Never stare into the laser emitting window. 

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so 
may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent 
the above accidents, make sure that a wall or similar which can block the laser beam is 
located behind the object.

Memo To perform step shot scan using the rotating stage, connect the stage to the computer, turn ON the power to the stage 

and check that the stage is recognized by the computer.

Ref. For details of the File-Import-Digitizer-Step Scan command, refer to page 60, in the Polygon Editing Tool Instruction 

Manual.

[Operating Procedure] 

1 From the [File] menu, select [Import], 

[Digitizer] and then [Step Scan].

The [File-Import-Digitizer-Step Scan] 

dialog box will appear.

2 Place the object on the rotating table.

A monochrome image taken by the VIVID 

910 will appear in the Image area of the 

dialog box.

3 To display the object in the middle of 

the window, change the position of the 

object or move the instrument back and 

forth to change the view angle.

Note If the object is not positioned in the middle of the 

window, it may not be scanned properly.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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4 To view the color image, click the [Color] button.

A color image taken by the VIVID 910 will appear in the Image area of the dialog box.

Note If the distance or angle to the object has been changed, click the [Mono] button to display the monochrome image to 

check it.

5 Open the [Hardware] tab page, and select the desired rotation step for the turntable.

Setting 90  :  Scans the object at every 90 degrees (four times in total).

 60  :  Scans the object at every 60 degrees (six times in total).

 Other  : Allows you to specify the desired rotation step.

Memo If [Angle] is not active, the rotating stage is not recognized correctly by the computer.

Tip If the rotating stage is not recognized correctly by the computer, carry out the following procedure.

1. In the [Hardware] tab page, select the COM port to which the rotating stage is connected and the type of stage, then 

click the [Apply] button.

2. Re-connect the stage to the computer. If the stage moves slightly, it indicates that the stage is recognized.

3. If an error message “Turntable not found” appears, turn OFF the power to the stage, turn it ON again, and repeat the 

steps from 1.

6 Select a scan mode.

In the [Camera1] tab page, click the [Fine] or [Fast] radio button.

Setting Fast : Scans the image in approximately 0.3 seconds. However, the number of pixels will drop to approximately 1/4   

  of that taken in Fine scan mode.

  Fine : Produces an image with a resolution of 640 × 480.

7  From the [General] tab, click the [Scan] 

button.

Scan will start, and both color and range 

images will be displayed. The “Next angle: 

xx degree” message dialog box will also 

appear.

8 Click the [OK] button.

The turntable will turn to that angle, and 

then the object will be scanned for the next 

image.

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File

Step 1: Importing Image Data
V
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9 Repeat step 8 until shots from all the 

desired angles are captured.

When shots from all the desired angles 

are captured, the “Scan the chart? The 

turntable will be move.“ message dialog 

box will appear.

• Click the [OK] button. The rotating stage 

will start to rotate toward the angle 

(home position) where the calibration 

chart is to be measured.

 When the rotating stage has reached that 

angle (home position), the “Scanning 

the Calibration Chart.” dialog box will 

appear.

10 Place the calibration chart on the 
 rotating table.

11 Click the [OK] button.

12 Click the [Convert] button.

The [Remote-Convert] dialog box will 

appear.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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13 Enter the desired element name, and click 
 the [OK] button.“

The “Proceed to registration?” massage 

dialog box will appear.

Note The element name must consist  of  up to 31 

alphanumeric characters.

•  If the [Save CDM] checkbox is checked, 

the [Remote -Save]  dialog box will 

appear.

1. Enter a file name.

2. Click the [Save] button.

Note The f i le name must consist  of  alphanumeric 

characters only.

14 Click the [OK] button.

Registration of elements will be fine-

adjusted, and all the registered elements 

will appear.

Memo The element name specified at step 13 will appear 

together with the rotation angles in the element list.

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File

Step 1: Importing Image Data
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Opening a Saved Data File
To open element or scene files saved on the computer, follow the procedure given below.

Ref.  • For the method of saving element and scene files, refer to page 33,34.

  • For details of the File-Open command, refer to page 22, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Open] on the [File] menu.

The [File-Open] dialog box will appear.

2 From the “Look in” pull-down menu, 

select the folder in which the file to be 

opened is stored.

3 From the “File of type” pull-down menu, 

specify the type of file to be opened.

Setting Element files : Displays element files (.vvd).  

 Scene Files : Displays scene files (.scn). 

4 Click the file to be opened.

The file will be selected.

Memo In the case of element files, it is possible to select two 

or more. To select them, click them while holding 

down the [Shift] or [Ctrl] key.

5 Click the [Open] button.

The data of the selected file(s) will be 

imported and displayed in the screen.

Note In the case of scene files, only one can be opened. 

If elements have already been imported before 

opening a scene file, a dialog box will appear asking 

you whether to delete the elements.

 To continue to import a scene file, click the [OK] 

button.

Step 1: Importing Image Data

 Selecting a digitizer

 One Scan

 Step Scan

 Opening a Saved Data File
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Displaying Points
Vertices of each element can be displayed.
By default, vertices are hidden. If you want to show them, change the setting as follows.

Ref. For a description of how to Show Vertex/Hide Vertex, refer to the Polygon Editing Tool Instruction Manual (page 226).

[Operating Procedure]

1 Click the right mouse button on a view 

window while holding down the [Ctrl] 

key. A popup menu will appear.

2 From the pop-up menu, click [Show 

Vertex]. 

The vertices will be shown.

Memo If vertices are already shown, [Hide Vertex] is 

currently selected.

  By default, F9 is assigned as the shortcut key for this 

function.

Step2: Changing the Element View Mode
This section explains how to change the way elements are displayed to 
facilitate selection of points and processing/ editing of data.

Step 2: Changing the Element View Mode

 Displaying Points

 Zoom

 Orbit

 Switching the Rendering Mode
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Zoom
To enlarge or reduce the element displayed in an element window, follow the procedure given below.

Ref. For details of the View-Zoom command, refer to page 123, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Zoom] on the [View] menu.

View-Zoom mode will be active.

Memo To cancel the View-Zoom mode, select the View- 

Zoom command again.

2 To enlarge the element, click the left 

mouse button in the element window 

and drag the mouse upward.

Memo The data displayed while dragging the mouse is 

simplified display data.

Ref. For recalculation of simplified display data, refer to 

page 161, in the Polygon Editing Tool Instruction 

Manual.

3 To reduce the element, click the left 

mouse button in the element window 

and drag the mouse downward.

Step 2: Changing the Element View Mode

 Displaying Points

 Zoom

 Orbit

 Switching the Rendering Mode
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4 To move the camera, click the right 

mouse button in the element window 

and drag the mouse in the desired 

direction.

Ref. For a description of the camera, refer to page 126, in 

the Polygon Editing Tool Instruction Manual.

Orbit
To rotate the element displayed in an element window, follow the procedure given below.

Note This command is effective only for the “Perspective” or “Isometric” element window.

Ref. For details of the View-Orbit command, refer to page 122, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Orbit] on the [View] menu.

View-Orbit mode will be active.

Memo •  Usually, this operation is not required, because 

View-Orbit mode is active in the initial condition. 

However, it is necessary to click [Orbit] if View-

Orbit mode is not active.

  •  To cancel the View-Orbit mode, select the View- 

Orbit command again.

2 Click the left mouse button in the 

“Perspective” or “Isometric” element 

window and drag the mouse in the 

desired direction. The element will 

rotate in the direction in which the 

mouse is dragged.

Memo The data displayed while dragging the mouse is 

simplified display data.

Ref. For recalculation of simplified display data, refer to 

page 161, in the Polygon Editing Tool Instruction 

Manual.

Step 2: Changing the Element View Mode

 Displaying Points

 Zoom

 Orbit

 Switching the Rendering Mode
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Switching the Rendering Mode
To switch the rendering mode for the element, follow the procedure given below.

Ref. For a description of rendering mode, refer to the Window-Property command (page 210), in the Polygon Editing Tool 

Instruction Manual.

[Operating Procedure]  

1 Click the element window for which you 

want to change the rendering mode.

2 Click the  tool button.

The element will be displayed in wireframe 

mode.

3 Click the  tool button.

The element will be displayed in shading 

mode.

4 Click the  tool button.

The element will be displayed in texture-

mapping mode.

Step 2: Changing the Element View Mode

 Displaying Points

 Zoom

 Orbit

 Switching the Rendering Mode
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Selecting an Element
If two or more elements have been imported, select the target element from the element list.

[Operating Procedure]  

1 Check the checkbox of the desired 

element name in the element list.

The selected element will be displayed in 

an element window.

Memo If  is clicked to clear the check mark, the element will 

not be displayed.

2 Click the desired element name in the 

element list to highlight it.

The element will be selected.

Memo To select two or more elements, click their names 

while holding down the [Shift] or [Ctrl] key.

Step3: Selecting the Item to be Processed/Edited
This section explains how to select the elements or points to be processed/
edited.

Step3: Selecting the Item to be Processed/Edited
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 Selecting an Element
 Displaying Points
 Canceling the Selected Points
 Reversing the Selection state of Point
 Selecting Points within the Specified Rectangle Area
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Displaying Points
To process/edit an element, display its points so that you can see which points have been selected.

Ref. For details of the Window-Property command, refer to page 210, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click the element window where points 

are to be displayed.

The clicked element window will become 
active.

2 Click [Property] on the [Window] menu.

The [Property Dialog] dialog box will 

appear.

3 Click the [Show Points] checkbox in 

“Display” section to place a check mark.

4 Click the [Apply] button.

Points will be displayed in the element 

window.

5 Click the [OK] button.

The [Property Dialog] dialog box will 

disappear.

Step3: Selecting the Item to be Processed/Edited

 Selecting an Element
 Displaying Points
 Canceling the Selected Points
 Reversing the Selection state of Point
 Selecting Points within the Specified Rectangle Area
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Canceling the Selected Points
To cancel the currently selected points, follow the procedure given below.

Ref. For details of the Select-Unselect by Elements command, refer to page 145, in the Polygon Editing Tool Instruction 

Manual.

[Operating Procedure]  

1 Click [Unselect by Elements] on the 

[Select] menu.

The currently selected points will all be 

unselected (displayed in blue).

Reversing the Selection state of Points
To reverse the selection state of points of the currently selected element(s), follow the procedure given 
below.

Ref. For details of the Select-Toggle Points command, refer to page 143, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Toggle Points] on the [Select] 

menu.

The currently selected points will  be 

unselected (i.e. displayed in blue), and the 

currently unselected points will be selected 

(I.e. displayed in red).

Step3: Selecting the Item to be Processed/Edited

 Selecting an Element
 Displaying Points
 Canceling the Selected Points
 Reversing the Selection state of Point
 Selecting Points within the Specified Rectangle Area
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Selecting Points within the Specified Rectangle Area
To select the points to be processed/edited within the specified rectangle area, follow the procedure 
given below.

Note For the element window in which the selected points are to be edited, make sure that necessary 
settings to display points are made.

Ref. For details of the Select-Rectangle command, refer to page 136, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 To facilitate selection of points, enlarge or 

rotate the target element.

Ref. For a description of changing the element view mode, refer to 

page 20-23.

2 Click [Rectangle] on the [Select] menu. 

Select-Rectangle mode will be active.

Memo When the view mode is switched from one to another 

(e.g. to Select-Rectangle mode), menus and icons 

will be invalidated and selection of commands is not 

possible until the mode is cancelled.

3 Click the left mouse button at the 

desired start position, drag the mouse 

to the desired end position, and then 

release the mouse button.

A rectangle will be drawn, and all the points 

present in the rectangle will be selected 

(displayed in red).

Memo Clicking the right mouse button and dragging the 

mouse to draw a rectangle will cause all the points 

present in the rectangle to be unselected (i.e. will be 

displayed in blue).

4 Repeat step 3 until all the desired points 

are selected.

5 Press the [ESC] key.

Select-Rectangle mode will be cancelled.

Step3: Selecting the Item to be Processed/Edited

 Selecting an Element
 Displaying Points
 Canceling the Selected Points
 Reversing the Selection state of Point
 Selecting Points within the Specified Rectangle Area

V
IV

ID
 9

i
V

IV
ID

 9
10

PET210_E.indd   27 06.1.18   5:21:29 PM



28

Deleting Points
To select and delete unnecessary points, follow the procedure given below.

Ref. For details of the Edit-Delete-Points command, refer to page 150, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Select the unnecessary points.

Ref. For a description of how to select points, refer to 

page 27.

2 From the [Edit] menu, select [Delete] 

and then click [Points].

The selected points will be deleted.

Step4: Processing/Editing Data
This section explains how to process/edit the currently selected elements 
or points.

Step4: Processing/Editing Data

 Deleting Points
 Performing Registration of Elements
 Merging Elements
 Undo
 Redo
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Performing Registration of Elements
To designate corresponding points of the elements obtained when the same object was scanned from 
different angles without the turntable, follow the procedure given below.

Ref. For details of the Build-Registration-Initial-Manual command, refer to page 163, in the Polygon Editing Tool 

Instruction Manual.

[Operating Procedure]  

1 Select the desired two elements from 

the element list.

Ref. For a description of selecting elements, refer to page 

24.

2 From the [Build] menu, select [Registration], 

[Initial] and then click [Manual].

The [Build-Registration-Initial-Manual] 

dialog box will appear.

3 Select the basis element (i.e. the element 

to be used as the reference element for 

registration), and click the [OK] button. 

Build-Registration-Initial-Manual mode 

will be active, and the both of elements will 

be texturemapped.

Memo When the view mode is switched from one to 

another (e.g. to Build-Registration-Initial-Manual 

mode), menus and icons will be invalidated and 

selection of commands is not possible until the 

mode is cancelled.

Step4: Processing/Editing Data

 Deleting Points
 Performing Registration of Elements
 Merging Elements
 Undo
 Redo
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4 Click the corresponding points in each 

element window with the left mouse 

button.

 A marker (   mark) will be displayed for 

each clicked corresponding point.

5 Repeat step 4 until more than three 

pairs  of  corresponding points are 

designated for the desired elements.

Memo Since the order of designating corresponding points 

is not fixed, designation can be started from any 

window.

6 Click the right mouse button.

The initial registration will start, and the 

result will be displayed. A message dialog 

box will also appear asking whether the 

result is satisfactory.

Memo If the registration result is not satisfactory, click the 

[Retry] button to return to step 4.

7 Click the [OK] button.

The initial registration will end, and a dialog 

box will appear, allowing you to check the 

results.

Memo •  Pressing the [Repeat] button will perform fine-  

adjustment.

 •  The values shown in Error Average and Sigma are 

guidelines to help you know how well registration 

is performed. The closer to zero they are, the more 

accurate registration is.

8 Click the [OK] button.

Build-Registration-Initial-Manual mode 

will be cancelled, and registration of 

elements is now complete.

Step4: Processing/Editing Data

 Deleting Points
 Performing Registration of Elements
 Merging Elements
 Undo
 Redo
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Merging Elements
To merge the registrated elements to create a new element, follow the procedure given below.

Ref. For details of the Build-Merge command, refer to page 181, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Select the desired elements from the 

element list.

Ref. For a description of selecting elements, refer to page 

24.

2 Click [Merge] on the [Build] menu.

The [Build-Merge] dialog box will appear.

3 Click the [OK] button.

A dialog box will appear, allowing you to 

enter a new element name.

4 Enter the desired name for the new 

element to be created, and click the [OK] 

button.

The elements will be merged and a new 

element will be created.

Note The element name must consist  of  up to 31 

alphanumeric characters.

Step4: Processing/Editing Data

 Deleting Points
 Performing Registration of Elements
 Merging Elements
 Undo
 Redo
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Undo
To cancel the previous operation and return to the state in effect before the previous operation was per-
formed, follow the procedure given below.

Ref. For details of the Edit-Undo command, refer to page 148, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Undo] on the [Edit] menu.

The previous operation will be cancelled, and the state in effect before the previous operation was 

performed will be restored.

Note The Undo function is not effective for some commands and operations.

Redo
To perform the operation that has been canceled by the Edit-Undo command, follow the procedure 
given below.

Ref. For details of the Edit-Redo command, refer to page 148, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Click [Redo] on the [Edit] menu.

The operation which has been canceled by Undo will be performed.

Step4: Processing/Editing Data
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 Deleting Points
 Performing Registration of Elements
 Merging Elements
 Undo
 Redo
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Saving Elements
To save the data selected in the element list as an element file (.vvd), follow the procedure given below.

Ref. For details of the File-Save-Elements command, refer to page 24, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 Fro m  t h e  e l e m e n t  l i s t ,  s e l e c t  t h e  

elements to be saved by clicking them.

Ref. For a description of selecting elements, refer to page 

24.

2 From the [File] menu, select [Save] and 

then click [Elements].

The [File-Save-Elements] dialog box will 

appear.

Memo If the selected element data is that of an element file 

that has been imported, the data will be overwritten. 

No dialog box will be displayed.

3 From the “Save in” pull-down menu, select 

the folder to which the file is to be saved.

4 Enter the desired file name, and click the 

[Save] button.

The element data will be saved.

Note The f i le name must consist  of  alphanumeric 

characters only.

Step5: Saving Data
This section explains how to save the data which has been imported to the 
Polygon Editing Tool.

Step5: Saving Data

 Saving Elements

 Saving a Scene

 Converting to Other Formats
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Saving a Scene
The currently opened elements and their view information (zoom setting, viewing direction, view mode) 
can be saved as a scene file (.scn). When you want to save the current state before or during starting pro-
cessing/ editing data, save the scene file as explained below.

Ref. For details of the File-Save-Scene command, refer to page 25, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 From the [File] menu, select [Save] and 

then click [Scene].

The [File-Save-Scene] dialog box will 

appear.

Memo If the currently opened data is that of a scene file that 

has been imported, the data will be overwritten. No 

dialog box will be displayed.

2 From the “Save in” pull-down menu, select 

the folder to which the file is to be saved.

3 Enter the desired file name, and click the 

[Save] button.

The scene data will be saved.

Note The f i le name must consist  of  alphanumeric 

characters only.

Step5: Saving Data

 Saving Elements

 Saving a Scene

 Converting to Other Formats
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Converting to Other Formats
To convert the data selected in the element list to other data formats, follow the procedure given below.

Ref. For details of the File-Export-Elements command, refer to page 111, in the Polygon Editing Tool Instruction Manual.

[Operating Procedure]  

1 From the [File] menu, select [Export] and 

then click [Elements].

The [File-Export-Elements] dialog box will 

appear.

2 From the “Export in” pull-down menu, 

select the folder to which the converted 

file is to be saved.

3 Enter the desired file name.

Note The f i le name must consist  of  alphanumeric 

characters only.

4 From the “File as type” pull-down menu, 

select the data format in which the file is 

to be converted.

5 Click the [Export] button.

The data will be saved in the selected file 

format.

Step5: Saving Data
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 Saving a Scene

 Converting to Other Formats
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   • Ref. shows the pages of the contents, the commands, and the names of the manuals.
 For the detail of the commands and the operating methods, please refer to each part of the reference 
manuals.

Case 1
To scan an object using the turntable and save the acquired data in a DXF file, follow the procedure given 
below.

[Operating Procedure]  

1 Perform step scan.

Ref. command : File-Import-Digitizer-Step Scan

 Polygon Editing Tool Instruction Manual / VIVID 9i …P.91   VIVID 910 …P.60

2 Merge the desired elements to one element.

Ref. command : Build-Merge

 Polygon Editing Tool Instruction Manual / P.181

3 Convert the merged element data to the desired format.

Ref. command : File-Export-Elements

 Polygon Editing Tool Instruction Manual / P.111

Operation Tips
This section gives some examples of data processing/editing using this Polygon Editing Tool.
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Case 2
To scan an object a few times because its data cannot be acquired by one scan and save the imported 
elements after deleting unnecessary parts from them, follow the procedure given below.

[Operating Procedure]  

1 Perform one scan as many times as you need.

Ref. command : File-Import-Digitizer-One Scan

 Polygon Editing Tool Instruction Manual / VIVID 9i …P.83   VIVID 910 …P.55

2 Perform registration of the desired elements.

Ref. command : Build-Registration-Initial-Manual

 Polygon Editing Tool Instruction Manual / P.163

3 Merge the elements to one element.

Ref. command : Build-Merge

 Polygon Editing Tool Instruction Manual / P.181

4 Change the view mode so that unnecessary parts of the data can be easily selected.

Ref. • command : View-Zoom

 Polygon Editing Tool Instruction Manual / P.123

 • command : View-Orbit

 Polygon Editing Tool Instruction Manual / P.122

5 Display points in the element windows.

Ref. command : Window-Property

 Polygon Editing Tool Instruction Manual / P.210

Operation Tips
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6 Select the unnecessary points.

Ref. • command : Select-Unselect by Elements

 Polygon Editing Tool Instruction Manual / P.145

 • command : Select-Toggle Points

 Polygon Editing Tool Instruction Manual / P.143

 • command : Select-Rectangle

 Polygon Editing Tool Instruction Manual / P.136

7 Delete the selected points.

Ref. command : Edit-Delete-Points

 Polygon Editing Tool Instruction Manual / P.150

8 Saves the elements.

Ref. command : File-Save-Elements

 Polygon Editing Tool Instruction Manual / P.24

Operation Tips
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Case 3
With some objects, their entire image data cannot be acquired even by Step Scan, because of their shape. 
In addition, to acquire complete 3D data by scanning the top and bottom surfaces of the object, scan 
must be repeated and each data must be merged after registration.

[Operating Procedure]  

1 Perform step scan around the object.

Ref. command : File-Import-Digitizer-Step Scan

 Polygon Editing Tool Instruction Manual / VIVID 9i …P.91   VIVID 910 …P.60

2 Change the view mode so that unnecessary parts of the data can be easily selected.

Ref. • command : View-Zoom

 Polygon Editing Tool Instruction Manual / P.123

 • command : View-Orbit

 Polygon Editing Tool Instruction Manual / P.122

3 At the angles that did not produce sufficient scan at step 1, repeat one scan as many times as 

needed.

Ref. command : File-Import-Digitizer-One Scan

 Polygon Editing Tool Instruction Manual / VIVID 9i …P.83   VIVID 910 …P.55

4 Perform registration of the elements acquired at steps 1 and 3.

Ref. command : Build-Registration-Initial-Manual

 Polygon Editing Tool Instruction Manual / P.163  

5 Merge the elements to one element.

Ref. command : Build-Merge

 Polygon Editing Tool Instruction Manual / P.181

Operation Tips
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6 Re-position the object, and perform one scan on its top and bottom surfaces.

Ref. command : File-Import-Digitizer-One Scan

 Polygon Editing Tool Instruction Manual / VIVID 9i …P.83   VIVID 910 …P.55

7 Perform registration of the element merged at step 5 and that scanned at step 6.

Ref. command : Build-Registration-Initial-Manual

 Polygon Editing Tool Instruction Manual / P.163

8 Merge the elements to one element.

Ref. command : Build-Merge

 Polygon Editing Tool Instruction Manual / P.181

9 Saves the element.

Ref. command : File-Save-Elements

 Polygon Editing Tool Instruction Manual / P.24

Operation Tips
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Case 4
To scan objects from one to another continuously and effectively under the same conditions using the 
bench top frame set, follow the procedure given below.

Note The bench top frame set is for use with the VIVID 910 only. It can not be used with other VIVID digitizers.

[Operating Procedure]  

1 Assemble the bench top frame set and mount the VIVID 910 on it.

Ref. For details of the assembly method for the bench top frame set.

 Bench Top Frame Set Instruction Manual

2 Scan the first object in step scan mode.

Memo Make sure that the calibration chart data is saved.

Ref. command : File-Import-Digitizer-Step Scan

 Polygon Editing Tool Instruction Manual / P.60

3 Save the elements.

Ref. command : File-Save-Elements

 Polygon Editing Tool Instruction Manual / P.24  

4 Place the next object on the rotating stage and perform step scan.

Ref. command : File-Import-Digitizer-Step Scan

 Polygon Editing Tool Instruction Manual / P.60

5 Save the elements.

Ref. command : File-Save-Elements

 Polygon Editing Tool Instruction Manual / P.24

6 Repeat steps 4 and 5 until all the remaining objects are scanned.

Operation Tips

V
IV

ID
 9

i
V

IV
ID

 9
10

PET210_E.indd   41 06.1.18   5:22:09 PM



42

Note This function is for use with the VIVID 910 only.

Adhere markers to the object to be scanned, and then take multiple scans at different angles. You can 
then align and import the data from these scans.

Ref. For information about the File-Import-Digitizer-Easy Align command, refer to page 101, in the Polygon Editing Tool 

Instruction Manual.

Starting Easy Align
In order to use this function, start Easy Align from the Polygon Editing Tool.

Memo The Easy Align software is incorporated in the Polygon Editing Tool so there is no need to install it separately; however, a 

license is necessary to use all of its features. In addition, it is necessary that the VIVID 910/VI-910 be connected to the PC 

until Easy Align has finished starting up.

[Operating Procedure]  

1 From the [File] menu, select [Import] – 

[Digitizer] and click [Easy Align].

The program opens a temporary window in 

the upper half of the main window. 

I f  this is the very first time you have 

executed this command (and if a VIVID 

910/ VI-910 is connected), the program will 

display the “License failure.” warning dialog. 

This is because you have not yet entered 

your license code.

Memo If you are using the command for the first time but 

you have not connected a VIVID 910/VI-910, the 

program will display a warning dialog informing 

you that there is no VIVID 910/VI-910 connected. 

In this case the program will not display a “License 

failure.” warning, and you will be able to continue to 

subsequent steps of the procedure without entering 

a license code. But because you have not entered the 

license code, you will not be able to make any use of 

the final aligned data.

• I f the program has already verified 

your license, it opens the [File-Import-

Digitizer-Easy Align] dialog.

2 Click the [OK] button.

If a VIVID 910/VI-910 is connected, the 

program opens the license-code entry 

dialog.
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3 Enter the license code that you have obtained, and then click the [OK] button.

The program opens the [File-Import-Digitizer-Easy Align] dialog.

• The left window in the dialog (the “work window”) displays the image captured by the VIVID 910/

VI-910, in monochrome. The right window (the “store window”) does not yet display anything.

Note If you entered an incorrect license code, or if you canceled the license-code entry process, the [Con-
vert] button will not be enabled on the dialog. This means that you will not be able to make use of 
the aligned data.
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Easy Align

VIVID 910/VI-910 Calibration
In the Easy Align, position alignment is carried out based on the marker information gotten from the 
markers affixed to the object to be measured. Adjustment is carried out by implementing calibration of 
the White Balance adjustment and Color Chart under the same lighting conditions as those used for the  
actual scan in order to get stable and correct marker information.

Warning
Never stare into the laser emitting window. 

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so 
may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent 
the above accidents, make sure that a wall or similar which can block the laser beam is 
located behind the object.

Memo In performing VIVID 910/VI-910 calibration, always be sure to attach the same lens that will be used during the actual scan 

of the object to be measured.

[Operating Procedure]  

4 Adjust the white balance on the VIVID unit, and check the light source.

Because the Easy Align command must automatically detect the markers adhered to the scanned 
object, lighting conditions are of critical important. This means that it is necessary to adjust 
the white balance at the VIVID unit before using the command, and it is important to keep the 
illumination conditions constant during measurements.

Note The Easy Align command cannot be used if you are working near a window exposed to the midday 
sun, or if you are using a tungsten-color fluorescent light source.

Memo The recommended light source is a daylight-colored fluorescent lamp with a brightness that is appropriate for a typical 
office environment (about 500 lux).

Ref. For information about how to carry out white-balance adjustment, refer to page 43, in the VIVID 910/VI-910 Instruction Manual.

5 Click the [Parameters] tab.

6 Click the [Settings] button.

The name of the button changes to [Calibration].

Note The [Settings] button does not appear if [Auto Marker Detection] checkbox is unchecked. 
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7 Place the supplied color chart same 

position as the object to be scanned.

Set the lighting to the same conditions 

you will use when carrying out the actual 

scan. Set the color chart so that it is directly 

facing the VIVID 910/VI-910 lens.

Note It is important to set this up so that you will 
scan only the color chart and nothing else. 
Check the image display in the dialog (see 
illustration below) to make sure that the 
scan will cover the color chart only.

8 Click the [Calibration] button.

The program executes calibration so as to 

improve the accuracy of marker detection. 

If calibration is successful, the “Calibration 

success.” dialog appears.

• I f  calibration is not successful,  the 

“Calibration failure.” dialog appears. 

If this happens, click the dialog’s [OK] 

button and return to Step 4. Adjust 

the lighting conditions, the imaging 

parameters, and the positioning as 

appropriate, and then try calibration 

again.

9 Click the [OK] button.

The dialog closes. This completes the 

calibration.
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Easy Align

Scanning Preparations
Attach the markers, decide on the image angle and select Scan Mode so that automatic alignment of the scan
data can be carried out by Easy Align. 

[Operating Procedure]

10 Adhere the markers onto the object.
Markers are available in three sizes: S, M, and L. Select the appropriate size based on the object’

s size, the lens your are using, and the measurement distance. Attach markers at appropriate 

intervals, in accordance with the marker spacing values indicated in the table below.

Measured range
(H × V)

Lens and Distance
Marker size Marker spacing

Telephoto lens Mid-size lens

200×150 mm less than 1200 mm  less than 600 mm  S  ( φ 9 mm)  50 mm

400×300 mm less than 2500 mm  less than 1200 mm  M  ( φ 15 mm)  100 mm

640×480 mm -  less than 2000 mm  L  ( φ 21 mm)  200 mm

Memo To obtain precise alignment when carrying out the Easy 

Align command, the program must correctly recognize at 
least three markers on each scan. Furthermore, for any two 
successive scans taken at different angles, the program 
must recognize at least three common markers (i.e., it must 
recognize at least three matching marker IDs). Keep these 
requirements in mind when adhering the markers, and 
adhere as many markers as practicable. If it is not possible 
to stick markers directly on the object, or if you are taking 
repeated scans of similar objects, a convenient alternative is 
to place the object on a pedestal and stick the markers onto 
the pedestal rather than the object. Then scan the pedestal 
together with the object.

11 Adjust the position of the object and move the
 VIVID 910/VI-910 forward or back as necessary 

to get the right viewing angle, so that the 
object appears at the center of the display.

The [Mono] radio button in the dialog should 

be On, so that you can check the viewing angle 

on the screen while setting up the object. (If you 

are checking the view by through the VIVID 910/

VI-910 viewfinder, however, then you should set 

the [Color] radio button On.)

Note Set the object and the VIVID unit so that at least three markers are visible.

12 Click the [Scan Mode] tab.

13 Select the scan mode by clicking the appropriate button: either [FINE] or [FAST].

Setting Fast : Scans the image in approximately 0.3 seconds. However, the number of pixels will drop to approximately 1/4 of
    that taken in Fine scan mode.

 Fine : Produces an image with a resolution of 640 × 480.
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Executing Easy Align
The object to be measured is scanned and the data is then aligned and fetched.

Memo When scanning, always be sure to use the same lens that was used when the VIVID 910/VI-910 calibration was carried out.

Warning
Never stare into the laser emitting window. 

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so 
may converge the laser beam, resulting in damage to your eyes, burns or fire. To prevent 
the above accidents, make sure that a wall or similar which can block the laser beam is 
located behind the object.

[Operating Procedure]

14 Click the [Scan] button to carry out the first
 scan.

The program takes the scan and displays 

the resulting color image in the work 

window on the left of the dialog. It also 

automatically detects the markers, and 

displays a single character (0 to 9 or A to 

Y) for each “marker ID” (0 to 34) in each 

location at which a marker was detected.

If the scanned data is good enough for alignment processing, the condition bar (under the work 

window) becomes blue (Good condition), indicating that the conditions are good. If the scan 

results are not good enough for alignment, the condition bar turns red (No good), indicating that 

the setup is not good. For the first scan, the bar will be blue if the program successfully detected at 

least three markers; otherwise the bar will be red.

Memo On the color image, areas that have no distance data are displayed as black.

•  If you have checked the [Auto] checkbox (above the [Store] button) and if conditions are good (if 

the bar is blue), the program will automatically continue processing up through Step 16.

•  If the program fails to detect at least three markers, the condition bar will be red. In this case, 

recheck the lighting conditions, the marker orientations, and the size, and then take the scan 

again. If necessary, return to Step 4 and start again from calibration.

Note If the [Auto Marker Detection] checkbox is unchecked, the program will not carry out automatic 
marker detection.
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15 If necessary, adjust the marker correspondences.

•  If any of the detected marker IDs does not match the corresponding marker on the actual object, 
correct as follows: right-click the marker ID on the image, and then enter the correct marker ID at 
the dialog that opens.

• If any of the marker IDs displayed on the stored image (the image stored at Step 16 below) does 
not match the corresponding marker ID displayed on the image scanned at Step 14 above, 
correct as follows: Left-click the mismatched ID in either of these two images, and then left-click 
on the correct corresponding marker ID in the other image. The program will change the IDs so 
that they are identical.

• To set up a “new” marker ID on images from Step 14 and Step 16 in a location where there was 
no physical marker on the object (or where the program failed to detect a marker), leftclick the 
corresponding points in the two images. The program will set a marker ID of “*” at these points.

Note If the condition bar (under the work window) is red, this means that the data is not yet suitable for 
alignment. Adjust the marker correspondences and take other steps as necessary until the bar be-
comes blue.

16 Click the [Store] button.

The data displayed in the work window moves over into the store window on the right side of 
the dialog. Marker detection results continue to be indicated in the condition bar. The temporary 
window displays the data in 3D.

17 Change the angle of the object, and click the [Scan] button to take the second scan.

The program executes the scan and automatically detects the markers.
For this second scan and for all subsequent scans, the results will be good (the bar will be blue) if 
the program detects at least three of the markers that are already displayed in the 3D image in the 
temporary window.

•  If you have checked the [Auto] checkbox (above the [Store] button) and if conditions are good (if 
the bar is blue), the program will automatically continue processing up through Step 19.

 When you first runs the command, [Auto] checkbox is unchecked. We recommend, however, that 
you turn [Auto] on by checking the box. 

18 If necessary, adjust the marker correspondences.

•  If any of the detected marker IDs does not match the corresponding marker on the actual object, 
correct as follows: right-click the marker ID on the image, and then enter the correct marker ID at 
the dialog that opens.

• If any of the marker IDs displayed on the image stored at Step 16 does not match the 
corresponding marker ID displayed on the image scanned at Step 17, correct as follows: Left-
click the mismatched ID in either of these two images, and then left-click on the correct 
corresponding marker ID in the other image. The program will change the IDs so that they are 
identical.

• You can also set up a new marker ID on both images (the image from Step 16 and the image 
from Step 17) in a location where the program failed to detect a marker (or where no marker was 
present). To do this, left-click the corresponding points in the two images. The program will add a 
new marker at these points.

Note If the condition bar (under the work window) is red, this means that the data is not suitable for 
alignment. Adjust the marker correspondences as necessary to get a blue bar.
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19 Click the [Store] button.

The data from the second scan moves into the store window, and is aligned with the data that was 

already displayed. The temporary window shows a preliminary converted image (“pre-converted” 

image) of all of the stored data.

20 Repeat steps 17 to 19 as necessary to scan at all desired angles.

•  You can use the [<<Prev] button or [Next>>] button to move through the stored-data displays.

•  You can use the [Delete] button to delete unnecessary stored data.

21 If you have adjusted the marker correspondences, click the [Pre-Convert] button.

The image displayed in the store window is realigned based on the change in the marker 

correspondence, and the result appears in the temporary window.

22 Click the [Convert] button.

The program opens the [File-Import-

Digitizer-Easy Align-Convert] dialog.

•  If you do not enter the correct license 

code at Step 2, the [Convert] button will 

not be enabled.

23 Enter a name for the element, and click
 the [OK] button.

The temporary window (the window that was showing the pre-converted image) closes. The 

program converts the data that was displayed in the store window, and displays the resulting 

aligned data.

Note Enter an element name of up to 31 alphanumeric characters.

•  If the [Save Data] checkbox was checked, the program opens the [Save Data] dialog.

1. Enter a filename for the file to be saved.

2. Click the [Save] button.

Note The filename must be alphanumeric characters only.
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